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What is VersaWorks?
VersaWorks is a high-performance software raster image processor (RIP) offering the following features.
 Support for genuine Adobe PostScript 3. This makes it ideal for proofing and design work.
 Simple to operate, with a friendly, easy-to-understand user interface.
 Cutting features and support for printing and cutting machines. This gives you wide versatility for combinations of printing and cutting operations.
 Support for spot-color printing. Colors registered in the spot-color library are converted to process colors
and printed. In addition to the standard colors registered in the spot-color library, you can also create new
ones.
 A wide variety of productivity-enhancing output features as standard (tiling, automatic nesting, and more).
 Automatic software updates through Roland@NET.
 You can connect up to four printers or cutting machines to a single computer.
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About the Documentation
This machine comes with the following documentation.

Quick Start Guide (this document)

This describes how to install and set up VersaWorks, basic usage, and other such matters.

VersaWorks Help

This provides detailed descriptions of the commands you use for VersaWorks. For information not described
in this document, view the help.
"VersaWorks Help" is a user's manual intended for viewing on a computer screen. Installing the program
enables you to view the documentation.



“Installation Procedure” (p. 7)

To view, follow the steps below.
 Start VersaWorks, then go to the [Help] menu and click [Show Help].

 From the [Start] menu, click [All programs (or Programs)] - [Roland VersaWorks] - [Roland
VersaWorks Help].

Note: You can use "VersaWorks Online" to find out about updates to VersaWorks and learn about information
not included in this document or the help. To view VersaWorks Online, follow the steps below.
 Start VersaWorks, then go to the [Help] menu and click [VersaWorks Online].
The VersaWorks Online website appears.
(This requires an Internet connection and web browser on the computer you're using.)

4

Part 1:
Settings for VersaWorks
This explains how to make the settings to enable printing
using VersaWorks.
Installing VersaWorks.....................................................................6
System Requirements..................................................................6
Installation Procedure...................................................................7

Before Printer Connection and Settings.........................................9
Printer Connection and Settings................................................... 11
Network Connection...................................................................11
USB Connection.........................................................................12
When Connecting Multiple Printers............................................13

Making the Settings for Roland@NET..........................................14
What is Roland@NET?..............................................................14
Making the Settings for Roland@NET........................................14

Setting up the Client Computer.....................................................15
Windows Client...........................................................................15
Macintosh Client.........................................................................23

5

Installing VersaWorks
System Requirements
Operating system (OS)

Windows 7 Professional/Ultimate (32-bit edition/64-bit edition)
Windows Vista Business/Ultimate (32-bit edition/64-bit edition)

Processor

2.0-GHz or faster Intel Core 2 Duo recommended

Memory (RAM)

2 GB or more recommended

Video card and monitor

A resolution of 1,280 x 1,024 or more recommended

Free hard-disk space required as a working space

40 GB or more recommended

Hard-disk file system

NTFS format

Optical drive

DVD-ROM drive

Other requirements

 For network connection: Ethernet port
 For USB connection: USB port
 To use Roland@NET and VersaWorks Online: Internet connection
and web browser

For the latest information, see the Roland DG Corp. website (http://www.rolanddg.com/)
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Part 1: Settings for VersaWorks

Installing VersaWorks

Installation Procedure
Procedure



Log on to Windows with an account with "Administrators" rights.



Insert the Roland VersaWorks DVD-ROM in the DVD-ROM drive.

Shut down all other programs except Windows.

When the automatic playback window appears, click [Run menu.exe].
When the [User Account Control] window appears, click [Yes] (or [Allow]).


Select the language
you want to use.

Click [OK].


Click [Next].



Choose [I accept the terms
in the license agreement].

Click [Next].


Enter the user
information.

Choose [Anyone who uses
this computer (all users)].

Click [Next].

Continued on the next page

Part 1: Settings for VersaWorks
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Installing VersaWorks



Follow the messages to carry out setup and finish setting up the program.

If the setup window for the printer appears partway through, choose [Yes]
and click [Next].



Click [Finish].
Installation of the printer driver starts.


When the [Windows Security] window
appears, click [Install this driver software
anyway].
The window closes automatically when the process
finishes.


When the window prompting you to
restart the computer appears, click
[Yes] and restart the computer.
This completes the installation.
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Before Printer Connection and Settings
Check to make sure that you're using the latest version of VersaWorks. If VersaWorks is not at the latest version,
performing printing from the connected printer may not be possible.
 To perform this operation, connect the computer where VersaWorks is installed to the Internet.
 If upgrading cannot be accomplished by following the steps described below, contact your authorized Roland DG Corp. dealer or Roland DG Corp. Call Center.

Procedure



From the [Start] menu, select [All Programs] (or [Programs]), then [Roland VersaWorks],
then [Update Software].
When the [User Account Control] window appears, click [Yes] (or [Allow]).


Go to the [Settings] menu and choose
[Preferences].



Make the setting for manual updating.

To use a proxy server, select the
check box and type in the IP address
and port number.

Select the two check boxes, then
choose "All updates."

Click [OK].
Continued on the next page
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Before Printer Connection and Settings



Click [Check for update].

The window shown below appears, you're using the latest version of Roland VersaWorks

Click [OK].

Go to the [File] menu and choose
[Exit].
Close the [Manual Updater] window.
If update data is available, the [Select updates] window appears.


Select all of the check boxes that are
available for selection.

Click [Update].
The update data is downloaded.


Click [OK].
The upgrade is carried out.
This completes the update of VersaWorks to the latest version.
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Printer Connection and Settings
You can connect up to four printers or cutting machines to a single computer.
The connection method differs according to the printer model. Check the type of the connection port on the
printer you're using and follow the appropriate procedure below to make the connection.

Network Connection
This is for a printer with an Ethernet network connection using 100Base-TX or the like.

Procedure



Finish the preparations for connection on the printer, such as assigning an IP address to
the print server installed in the printer (Roland-PrintServer or the like).
For information on how to set the IP address, refer to the documentation for the print server you're using.





Make sure the power to the printer is switched on.
Connect the printer and the computer (the RIP server) to the network.
From the [Start] menu, click [All Programs (or Programs)] - [Roland VersaWorks] - [Roland VersaWorks] to start VersaWorks.
The [Printer Settings] window appears. It appears only when starting up for the first time.



Make the settings for the printer.
Choose [TCP/IP]. Enter the IP address
assigned to the printer (print server).

Click [Verify].

Enter a [Nick Name] for the printer.
If you do not set a nickname, the model name
is displayed.

If the connection is correct, information about the
printer you're using is displayed.

Click [Apply].
When the message [Do you want to install
printer driver?] appears, click [Next].
When the [Add Printer Wizard] appears,
click [Next].
The connected printer information appear in
the [Printer List].

Click [OK].
VersaWorks is now ready for use.
To continue by connecting one or more additional printers, go on to page 13, "When Connecting Multiple
Printers."

 “When Connecting Multiple Printers” (p. 13)
Part 1: Settings for VersaWorks
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Printer Connection and Settings

USB Connection
This is for a printer connected using a USB cable.
Please note that a USB connection requires a separate Windows-based driver included with the printer.

Procedure



Install the Windows-based driver for the printer you're using, then connect the printer
and the computer using a USB cable.
For information on how to perform installation, refer to the documentation for the printer you're using.




Make sure the power to the printer is switched on.
From the [Start] menu, click [All Programs (or Programs)] - [Roland VersaWorks] - [Roland VersaWorks] to start VersaWorks.
The [Printer Settings] dialog box appears. It appears only when starting up for the first time.



Make the settings for the printer.
Enter a [Nick Name]
for the printer.
If you do not set a nickname, the model name
is displayed.

The name of the printer is
not displayed. Choose the
port number of the connected printer.

If the connection is
correct, information
about the printer
you're using is displayed.

Click [Verify].

Click [OK].

Click [Apply].
When the message [Do
you want to install printer driver?] appears, click
[Next].
When the [Add Printer
Wizard] appears, click
[Next].
The connected printer
information appear in the
[Printer List].

VersaWorks is now ready for use.
To continue by connecting one or more additional printers, go on to page 13, "When Connecting Multiple
Printers."

 “When Connecting Multiple Printers” (p. 13)
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Printer Connection and Settings

When Connecting Multiple Printers
You can connect up to four printers or cutting machines to a single computer.
The explanations in this section assume that one printer is already connected, and describe how to connect
one or more additional printers

 “Network Connection” (p. 11) , “USB Connection” (p. 12)
Procedure



From the menu bar, click [Printer] - [Printer Settings].



Make the settings for the printer.
Click.
Enter a [Nick Name]
for the printer.
If you do not set a nickname, the model name is
displayed.

Choose the port.
Network Connection
Choose [TCP/IP].
 P. 11, Procedure
USB Connection
Choose [USB] .
 P. 12, Procedure

If the connection is
correct, information
about the printer
you're using is displayed.

Click [Verify].

To add more printers, repeat steps
through .

Click [OK].

Click [Apply].
When the message [Do
you want to install printer driver?] appears, click
[Next].
When the [Add Printer
Wizard] appears, click
[Next].
The connected printer
information appear in the
[Printer List].

VersaWorks is now ready for use.

Part 1: Settings for VersaWorks
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Making the Settings for Roland@NET
What is Roland@NET?
Roland@NET is a service that lets you obtain the latest information about products and software from Roland
DG Corp. over the Internet. When VersaWorks is set up to connect to Roland@NET, you are automatically notified when software updates become available. You can also download updated data.

Making the Settings for Roland@NET
Procedure




From the menu bar, choose [Edit], then click [Preferences].
Make the settings for Roland@NET.

Click the [Roland @NET]
tab.
Select this check box.
Choose how often updates
are provided.

To use a proxy server, select the check box and type
in the IP address and port
number.

Choose what to download.

When you're done making
all the settings, click [OK].

You are now done making the settings for Roland@NET.
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Setting up the Client Computer
The computer for creating image files is called a client computer. In contrast to this, the computer where VersaWorks is installed and set up is called the raster image processor (RIP) server. Connecting the client to the RIP
server over a network lets you send printing data from the client to the RIP server. In other words, you can use
the RIP server as a printer for the client. You can also combine the RIP server and client on a single computer.
When the client and the RIP server are different computers, you need to install a printer driver on the client.
Follow the steps below to install the printer driver.

Windows Client
Windows Vista/7



Make sure the RIP server is running, then log on to an account with "Administrators"
rights.


Windows Vista
From the [Start] menu, click [Control
Panel] then click [Printer].
Windows 7
From the [Start] menu, click [Device and
Printers].


Windows Vista
Click [Add a printer].

Windows 7
Click [Add a printer].

Continued on the next page
Part 1: Settings for VersaWorks
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Setting up the Client Computer


Click [Add a network, wireless or Bluetooth printer].



Click [The printer that I want isn't listed].



Choose [Browse for a printer] (or [Find a
printer in the directory, based on location
or feature]).

Click [Next].


Choose [RIPserver's computer name].

Click [Select].


Choose [RolandVW (the nickname of the
printer you want to use for output)].
When the [RolandVW] has been selected, output
is made to the printer appearing at the top of the
VersaWorks printer list.
Click [Select].
The printer is added.
When this window appears, click
[Install driver].
Continued on the next page
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Setting up the Client Computer


Windows Vista
Clear the "Set as the default printer"
check box.

Click [Next].


Windows 7
Clear the "Set as the default printer"
check box.

Click [Finish].
If you want to perform a printing test,
click [Print a test page].

This completes the settings for the client. You can print from the program in the same way as with other printers.

Part 1: Settings for VersaWorks
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Setting up the Client Computer

Windows 2000/XP



Make sure the RIP server is running, then log on to an account with "Administrators"
rights.



Windows XP

From the [Start] menu, open [Control Panel] then click [Printers and Other Hardware]. Click [Printers and
Faxes] and click [Add a printer].

Windows 2000

From the [Start] menu, click [Settings] - [Printers].
Double-click the [Add printer] icon.



Click [Next].



Choose [Network Printer].

Click [Next].


Choose [Browse for a printer].

Click [Next].
Continued on the next page
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Setting up the Client Computer


From the [Shared Printers] list, select [\\
(RIPserver's computer name) \RolandVW
(the nickname of the printer you want to
use for output)].
When the [RolandVW] has been selected, output
is made to the printer appearing at the top of the
VersaWorks printer list.

Click [Next].


When the window shown in the
figure appears, click [Yes].


Choose [No].

Click [Next].



Click [Finish].

This completes the settings for the client. You can print from the program in the same way as with other printers.

Part 1: Settings for VersaWorks
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Setting up the Client Computer

Windows 95/98/Me/NT4.0



Make sure the RIP server is running, then insert the Roland VersaWorks DVD-ROM in
the computer's DVD-ROM drive.
Although the setup menu appears automatically, click [x] button to exit the menu.


Double-click [My Computer].

Make sure the name of the DVD-ROM drive
is "VersaWorks," then right-click and select [Open].


Double-click [PrinterDriver].

Double-click [English] - [Windows95_98_NT].

Double-click [PSDriver_ENG.exe].
The Adobe PostScript driver installer
starts.



Click [Next].

Continued on the next page
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Setting up the Client Computer



Click [ACCEPT].


Click [Network Printer].

Click [Next].


Click [Browse].
The [Browse for Printer] window appears.
From the [Browse For Printer] list, select [\\
(RIP server's computer name)\RolandVW
(the nickname of the printer you want to use
for output)], then click [OK].
When the [RolandVW] has been selected, output
is made to the printer appearing at the top of the
VersaWorks printer list.
Click [Next].

Continued on the next page
Part 1: Settings for VersaWorks
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Setting up the Client Computer


Click [Browse].
The [Browse for Printer] window appears.

Select the DVD-ROM drive, then doubleclick [PrinterDriver] - [English] - [Windows95_98_NT].
Choose [RolandVW (the nickname of the
printer you want to use for output)], then
click [OK].


Choose [RolandVW (the nickname of the
printer you want to use for output)].

Click [Next].



In some cases, you may have to run a test print or the like before clicking [Finish].

This completes the settings for the client. You can print from the program in the same way as with other printers.
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Setting up the Client Computer

Macintosh Client
Check This First
What follows is an overview of the respective setup methods.
Before making the settings, check the following.
 The client is a Mac OS X (10.5 or later) machine
 The RIP server is logging on to an account that has administrator rights.
 The printer and the computers (RIP server and client) are connected correctly and are all switched on.
 The printer settings have been made in the RIP server.
 The printer is in a state in which printing is possible.

Part 1: Settings for VersaWorks
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Setting up the Client Computer

Setup Method
If you register the RIP server as a network printer on the client, you can send data to the RIP server for it to print.
* The screens shown in this explanation are for Mac OS 10.5.Mac OS 10.6. The setting method is the same
though there are some parts where externals of the screen are somewhat different form Mac OS 10.6 or later.

Setting up the client




Insert the Roland VersaWorks DVD-ROM in the computer's DVD-ROM drive.
Copy the PPD file to the computer.
Double-click the [VersaWorks] icon
on the desktop.

<Mac OS X 10.9 or later>
Double-click [For Macintosh] - [PPD
File] - [OS10.9 or later] - [English].
<Mac OS X from 10.5 to 10.8.5>
Double-click [For Macintosh] - [PPD
File] - [OS10.8 or ealier] - [English].

Copy the "Roland VersaWorks.
PPD" file to the desired location.
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Setting up the Client Computer



Get ready to make the printer settings.

Double-click [System Preferences]
- [Print & Fax] folder.
The [Print & Fax] window appears.

Click [+].



Make the network settings.
Choose [Windows].

Choose the network
group where the computer is connected.

From the list, choose the
computer name of the RIP
server.

Enter the username and password
for the RIP server.

Click [Connect].
Continued on the next page
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Setting up the Client Computer



Register the printer.

Choose [RolandVW (the nickname
of the printer you want to use for
output)].
When the [RolandVW ] has been selected,
output is made to the printer appearing at the
top of the VersaWorks printer list.

Select [Other] in the [Driver] list.

Choose the "Roland VersaWorks.
PPD" file you copied in step.

Click [Open].

Click [Add].

This completes the settings for the client. You can print from the program in the same way as with other printers.
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Starting VersaWorks
Starting the Program
This appears when starting VersaWorks.

From the [Start] menu, click [All programs (or Programs)] - [Roland VersaWorks] - [Roland VersaWorks].

The main window appears.
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Starting VersaWorks

Top Screen
This appears when starting VersaWorks.
Menu bar
This lets you carry out the settings
and operations for VersaWorks
from the various menus.

Main Window
This displays printer information and such elements
as the job list and the
toolbar.

Preview Window
This displays a preview of the job as
well as information about the file, printing settings, and the like.

Layout Window
This displays the layout
of the job.

Part 2: Getting Started
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Starting VersaWorks

Overview of the Toolbar
You can perform operations such as the following by clicking the corresponding buttons on the toolbar at
the bottom of the main window.
Open the [Job Settings] window.
Click this when you want to set the printing parameters for the selected job.

 “Setting the Printing Parameters for Jobs” (p. 50)
This performs RIP'ing (raster-image processing) for the selected job.
If you choose a job that has already been RIP'ed, then before it is processed, you're
prompted to confirm that you want to re-RIP it.

This performs RIP'ing and printing for the selected job.
This concatenates a number of jobs into a single job (a nested job).
Clicking this when a nested job has been chosen cancels the nesting, restoring
the previous state.

 “To RIP a Number of Image Files as a Group” (p. 47)
This saves the selected job.
You can select the format for saving the file according to the target. For more
information, refer to the help. For more information, refer to the help.

This stops RIP'ing, printing, or other processing.
To quit printing, stop the printing operation on the printer as well.
This deletes the metafile for the selected job, restoring the job to its
original state.
When modifications such as color adjustment have been performed, they are
returned to their original state. Data that has already been RIP'ed is deleted.

This deletes the selected job.

You can also perform this operation from the main menu.
Choosing items on the [Job] menu lets you perform the same operations as the buttons on the toolbar.
For more information, refer to the help.
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Performing Printing
This describes the most basic printing operations.
This section describes how to open and print a file directly in VersaWorks when the RIP server and the client
are the same computer.
Before you begin operation, make sure the printer is ready to perform printing.

Getting Ready to Print
First you make the basic settings for printing. Here you make the settings for the size and type of the media,
and for the printed image quality.

Procedure



Open the [Queue A properties] window.

Double-click
this.

Top Screen

Continued on the next page

[Queue Properties] window and Input folder
The data sent to VersaWorks is first placed in the input folder. When data enters the input folder, VersaWorks
uses it to create data for RIP'ing and previewing. At the [Queue Properties] window, you make the settings
for the processing method used at this time and for the operation of the printer when you perform printing.
VersaWorks has two input folders (Queue A and Queue B). You can make different settings for each and use
them selectively for different purposes.

 “Making the Default Settings for Printing” (p. 48)

Part 2: Getting Started
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Performing Printing



Make the settings for the size and type of the media to use for printing and for the
printing quality, then close the window.

Click [Get Media Width].
The printable media width is detected and set automatically.
The sensed media width is
displayed.

Click the [Quality] button.

Choose the type of the media
and the printing quality.

Click [OK].

The Media Settings
Clicking the [Get Media Width] button displays, at [W], the width of the printing area for the media loaded in
the printer. Note that this value is not the width of the loaded media.
Also, the value of [W] is not updated automatically. Whenever you change or reload the media, click the [Get
Media Width] button to update the width setting.
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Performing Printing

Importing and Printing a File Directly
When the client and the RIP server are the same computer, you can perform printing simply and easily by
opening the file directly from VersaWorks.

Procedure



Drag the icon for the file you want to print to [Job List].

The file name appears on the job list.
The preview window and the layout window display a preview of the image as well as the job settings
and other information.
An Icon for the file

Mouse
Drag

Continued on the next page

File Formats You Can Open Directly from VersaWorks
The file formats that you can open directly from VersaWorks are as follows.
PostScript, EPS, PDF, JPEG, TIFF (LZW-compressed or uncompressed files only)

What Is a Job?
The data that is used for RIP'ing and print processing is called a "job." When VersaWorks imports a file, it uses
it as the basis for creating data for RIP'ing or printing. Only the job data is used for actual RIP'ing and printing.
This means that even when you use VersaWorks to modify the colors or the printing size, the colors and size
in the original file do not change.

Part 2: Getting Started
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Performing Printing



Display the [Job Settings] window.
Double-click the job
you want to print.



Make the settings for the printing size and the number of copies, then close the window.
Click the [Layout] button.

Click the preview
on the layout
area.

If you want to
change the printing size (to make
it larger or smaller), enter values
either for [Rate]
or for [H] and [W].

Enter the number
of copies.

[Job Settings] window

Click [OK].

The [Job Settings] Window
 The aspect ratio for [H] (height) and [W] (width) cannot be changed. When you enter a value for one, the
value for the other one changes automatically.
 When you have increased the number of copies to print, you can adjust the layout in the layout area. For
more information, refer to the help.
 You can any of several methods to display the window. Use whichever method you prefer.

 “Setting the Printing Parameters for Jobs” (p. 50)
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Performing Printing



Start printing.

RIP'ing starts, and then printing begins.

Click

.

The Printing Progress Window

This indicates the status
of the printer.

This displays the progress.

This displays the
job being printed.

The icon appears while
RIP'ing or printing is in
progress.

You can stop RIP'ing or printing
in progress by pressing the
button.
 To quit printing, stop the printing
operation on the printer as well.

Part 2: Getting Started
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Performing Printing

Deleting Jobs
After printing has finished, delete unneeded jobs.

Choose the jobs you want to delete and delete them.
Choose a job.

These icons indicate a job for which
RIP'ing and printing have finished.

Click

.

Jobs for Which Printing Has Finished
 When you want to print the same job again later, retaining the job just as it is lets you skip RIP'ing the next
time you print the job.

 “To Re-output a Printed Job Rapidly” (p. 46)
 You can make the setting for deleting jobs automatically after printing has finished.
You can make the setting by displaying either the [Queue Properties] or [Job Settings] window, then using
[Job Management]. For more information, refer to the help.
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Part 3:
Advanced Use
This describes such operations as how to perform printing
from a program and how to manipulate jobs.
For information about other features, refer to " VersaWorks
Help."
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Printing from a Program
You can perform printing directly from the program you're using.
You can use the same procedure to perform printing regardless of whether the client and RIP server are
the same or different computers. Although the procedures you use to perform printing vary according to
the program you're using, this section described printing methods for typical programs. The examples for
Windows-based programs are for programs running under Windows XP/Vista/7, and the Macintosh examples
are for programs running under Mac OS X. The programs used as examples for explaining printing methods
are Adobe Illustrator CS to CS5 and CorelDRAW 12 to X5.

Windows XP/Vista/7
Procedure



Ready the printer and VersaWorks for printing.




Start the program and create the document to print. Alternatively, open the file to print.

 “Getting Ready to Print” (p. 31)

Display the window for making the driver settings.

From the [File] menu, click [Print].
The [Print] window appears.

Select "RolandVW (the nickname of the
printer you want to use for output)."

Click [Preferences] (or [Properties]).
The [Printing Preferences] window appears.

Click [Advanced].
The [Roland VersaWorks Advanced Options] window appears.
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Printing from a Program



Make the required settings for printing.
Make the setting for the media size.

Make the setting for the processing
method for jobs created on the RIP
server.

 “To Make the Settings for the Processing Method for
Jobs” (p. 41)

Click [OK].

Click [OK] on the [Printing Preferences]
window.



Start printing.

The printing data is sent to the RIP server.

Click [Print].

To Create a PostScript File
You can create a PostScript file from this file by going to the [Print] window, selecting the [Print to file] check
box, then performing printing. When you do this, the printing data is not sent to the RIP server.
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Printing from a Program

Mac OS X
Procedure



Ready the printer and VersaWorks for printing.




Start the program and create the document to print. Alternatively, open the file to print.

 “Getting Ready to Print” (p. 31)

Make the setting for the media size.

From the [File] menu, choose [Page Setup].
The [Page Setup] window appears.
Select "RolandVW" or the printer name
set at the RIP server (spooler name).

 “Check This First” (p. 23)
Select the media size.

Click [OK].

To Create a PostScript File
You can create a PostScript file by going to the [Print] window, using the shortcut menu to choose [Output
Options], making the settings as shown in the figure below, then clicking the [Print] button. When you do this,
the printing data is not sent to the RIP server.

Select [Output Options].
Select this check box.
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Select [PostScript].

Printing from a Program



Make the required settings for printing, then start printing.
The printing data is sent to the RIP server.

From the [File] menu, click [Print].
The [Print] window appears.

Check the printer name.

From the shortcut menu,
choose "Printer Features."

Make the setting for the processing method for jobs created on the RIP server.

 “To Make the Settings for the Processing Method for Jobs” (p. 41)

Click [Print].

To Make the Settings for the Processing Method for Jobs
The RIP server creates jobs from the printing data sent from the client.
In the [Printer Features] menu, select the processing method for the jobs.
[InputAction]
This selects the processing method for jobs created from the printing data sent to the RIP server.
 [UseRIPSetting]:
This performs operations according to the settings on the RIP server.
 [DoNothing]:
Neither RIP'ing nor printing is performed.
 [RIPOnly]: 		
This performs only RIP'ing.
 [RIPAndPrint]:
This performs RIP'ing and printing.
[OutputAction]
This selects the processing method for a job for which printing has finished.
 [Default]: 		
This performs operations according to the settings on the RIP server.
 [SaveJob]:		
The job still remains after finishing printing.
 [Clean]:		
This deletes the metafile for the job after finishing printing.
 [DeleteJob]:
This deletes all the data of the job after finishing printing.
You can also set the processing method for jobs on the RIP server. For information on how to make the setting
on the RIP server, refer to the help.
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Printing from a Program

Printing from Adobe Illustrator
This describes how to perform printing from Adobe Illustrator (CS/CS2/CS3/CS4/CS5). The screens shown in
this explanation are for Illustrator CS3 (Windows).

Procedure



Ready the printer and VersaWorks for printing.




Start Illustrator and create the document to print. Alternatively, open the file to print.



If you're using Windows, click [Setup]. If you're using a Macintosh, click [Printer...].
When a warning window appears, click [Continue].

 “Getting Ready to Print” (p. 31)

From the [File] menu, click [Print].
The [Print] window appears.

The [Print] window appears.



Make the settings for the [Printer Features] menu, then go back to the [Print] window.
Windows

 “Printing from a Program” (p. 38), steps
Macintosh

 “Mac OS X” (p. 40), step

 through 



Clicking [Print] here does not perform printing yet.

To Create a PostScript File
You can create a PostScript file in Illustrator. For information on how to do this, refer to the corresponding
page indicated below.
Windows

 “To Create a PostScript File” (p. 39)
Macintosh

 “To Create a PostScript File” (p. 42)
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Printing from a Program



Make the required settings for printing, then start printing.
The printing data is sent to the RIP server.

[General]

Print Preset: [Custom]
Printer: RolandVW (the nickname of the printer
you want to use for output)
PPD: Default (Roland VersaWorks)

Media:
While watching the preview window, make the
settings for the media size.
Choosing "Custom" lets
you change the media size
however you like.
Print Layers:
Visible & Printable Layers

Preview window

When you have finished making all the
settings, click [Print].
The printing data is sent to the RIP server.
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Printing from a Program

Printing from CorelDRAW
This describes how to perform printing from CorelDRAW (12/X3/X4/X5).The screens shown in this explanation
are for CorelDRAW X5 (Windows).

Procedure



Ready the printer and VersaWorks for printing.




Start CorelDRAW and create the document to print. Alternatively, open the file to print.



Display the window for making the driver settings.

 “Getting Ready to Print” (p. 31)

From the [File] menu, click [Print Setup].
The [Print Setup] window appears.

Select "RolandVW (the nickname of the
printer you want to use for output)."

Click [Properties].
The [Document Properties] window appears.

Click [Advanced].
The [Roland VersaWorks Advanced Options]
window appears.



Make the required settings for printing.
Make the setting for the media size.
To specify a custom size, choose [PostScript Custom
Page Size], then make the settings for the size you want.

Make the setting for the processing method for jobs
created on the RIP server.

 “To Make the Settings for the Processing Method for Jobs” (p. 41)

Click [OK].

Click [OK] to close the rest of the windows.
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Printing from a Program



Make the settings for the page layout.
From the [Layout] menu, choose [Page
Setup].
The [Options] window appears.
Make the settings for the media size.
Make the settings for the same size
as the media-size settings you made
in step. To specify a custom size,
choose [Custom], then make the setting for the same size as the size you
specified.

Click [OK].



Start printing.

The printing data is sent to the RIP server.
From the [File] menu, click [Print].
The [Print] window appears.

Click [Print].

To Create a PostScript File
You can create a PostScript file from this file by going to the [Print] window, selecting the [Print to file] check
box, then performing printing. When you do this, the printing data is not sent to the RIP server.
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Job Operations
To Re-output a Printed Job Rapidly
When printing is performed, the print job (that is, the data that has undergone RIP'ing) remains. When you
want to take something that has been printed once and print it a second time, you can skip RIP'ing by outputting the remaining print job.

Select the job you want to print a second time, then perform printing.

Click the job.

Click

.

To Change the Settings for the Job
When you want to take a job for which printing has finished and print it a second time with different settings,
display the [Job Settings] window and change the settings. At this time, you're prompted to confirm deletion of the metafile. To apply the settings changed at the [Job Settings] window, you need to click [Yes] and
delete the metafile.
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Job Operations

To RIP a Number of Image Files as a Group
You can group a number of jobs together into a single job (a nested job). When you make the settings for a
nested job, the individual jobs are automatically rearranged to minimize the amount of media used.

Procedure



Create a nested job from a number of jobs.

At [Job List], hold down the [Ctrl] key
and choose all the files you want to
print as a single batch.

Click

.

The image files you have chosen are
grouped together into a single "Nest Job."



Start printing.

Select [Nest Job].

Click
.
RIP'ing starts, and then printing begins.
Clicking the button in this state
clears the nesting.

About Nested Jobs
 It is not possible to make different individual settings for the printing quality and the media for the files
included in the nested job.
 You can create multiple nested jobs.
 You can set parameters and create nested jobs automatically. For information on how to make the settings,
refer to the help.
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Setting the Printing Parameters
You can display the [Queue Properties] and [Job Settings] windows and make basic settings as well as setting
the printing parameters for jobs. For detailed information on how to operate each window, refer to the help.

Making the Default Settings for Printing
To make the basic settings for printing, display the [Queue Properties] window. When the printing parameters
have not been set at the [Job Settings] window, all jobs are processed using the values set here. Two types of
queue settings -- A and B -- are available, and you can set different parameters for each. This makes possible
selective use according to the usage environment. For instance, you could use Queue A for the RIP server and
Queue B for the client.

How to Display the Window
Double-click either one.

Alternatively, you can display the window by going to the main menu and clicking [Edit], then [Queue A (or
B) Settings].
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Setting the Printing Parameters

Main Settings Items in the [Queue Properties] Window
Layout
Here you make the settings for the media, the printing size,enlargement or reduction, and the like.
Quality
Here you make the settings for the type of media,
printing quality, and the like.
Color Adjustment
Here you perform level correction and tone adjustment for the inks.
File format
Here you make the necessary settings to match the
file format and color settings of the original job file.
Mark
Here you make the settings that determine whether
to print crop marks, job information, and the like.
Printer Controls
Here you make the settings for printer operation
during printing.
Cut Controls
Here you make the settings for the cutting parameters and for printer operation during cutting.
Job Management
Here you make the settings for the location of the
input folder and the processing method for the job.

What is displayed varies according to the item selected.

Clip and Tile
Click this button to configure the settings for tiling
and over laps.
Variable print
Click this button to configure the settings for printing
images with variable text or image.
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Setting the Printing Parameters

Setting the Printing Parameters for Jobs
To make the settings for the printing parameters for jobs, display the [Job Settings] window. You can make
the settings for nearly all the features whose settings you can make at the [Queue Properties] window. The job
you specify at this window is processed according to values set with [Job Settings], regardless of the settings
made at [Queue Properties].

How to Display the Window






In the layout window or the Job List, directly double-click the job whose settings you want to make.
At the job list, right-click the job whose settings you want to make, then select [Job Settings].
Select the job, then click
on the toolbar.
Select the job, from the main menu, click [Job], then [Settings].
In the preview window, double-click the image.

Overview of the Window
This is composed of a settings area and a layout area.
In the settings area, you can make the settings for nearly all the features whose settings you can make at the
[Queue Properties] window.
The layout area lets you preview the results of actual printing. You can do things like changing the printing
location of an image by dragging the image directly and changing the layout for a nested job. Also, when you
adjust colors, you make the adjustments as you monitor the changes to the image in the layout area.

Settings area
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Layout area

Part 4:
Contour Cutting
This describes how to cut contours using VersaWorks and
draw cutting lines using a program.
Drawing Contour Lines.................................................................52
Creating a Cutting Path..............................................................52
Creating a Cutting Path with Adobe Illustrator............................53
Creating a Cutting Path with CorelDRAW..................................55

Contour Cutting.............................................................................60
Performing Printing Followed Immediately by Cutting................60
Reloading Detached Media and Performing Cutting..................61
Cutting Only................................................................................63

51

Drawing Contour Lines
Creating a Cutting Path
You can perform contour cutting using VersaWorks. If an image file contains cutting lines, you can perform
cutting along the lines.
You draw cutting lines with your program, using a certain specific color. There are a few rules that need to be
followed when you draw cutting lines.

1. Cutting Lines Drawn Using a Drawing Program
The cutting lines must be vector data. Paths drawn using a drawing program are typical examples of this.
The bitmap data used by paint programs cannot be made into cutting lines, even if the data is in the form of
narrow lines.

2. Cutting-line Color
When drawing cutting lines, be sure to use the spot color named "Cut Contour." VersaWorks recognizes as
cutting lines only the lines drawn with the color of this name.
When specifying the name, be sure to type it in accurately, using single-byte characters. The name is casesensitive -- incorrect use of upper- and lower-case letters when typing in the name will make detection as
cutting lines fail.
VersaWorks can generally recognize and cut cutting lines drawn according to the conditions just described.
Note, however, that the methods for making the settings vary according to the program you're using. Refer
to the documentation that comes with the program.
CutContour Spot Color Libraries for popular DTP applications can be found on the Roland VersaWorks DVDROM. Registering a library lets you draw cutting lines even more easily.
For reference, methods for drawing cutting lines using Adobe Illustrator and CorelDRAW are described below.
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Drawing Contour Lines

Creating a Cutting Path with Adobe Illustrator
The following tech note will walk you through creating a cutting path to use with VersaWorks from Adobe
Illustrator (10/ CS/CS2/CS3/CS4/CS5).

1. Register as a spot color in Illustrator's swatch library.



Insert the Roland VersaWorks DVD-ROM in the DVD-ROM drive.



For Windows
From the [Start] menu, choose [Computer (or My Computer)], then the DVD-ROM drive.
Right-click the DVD-ROM drive, then choose [Open].

If the setup menu appears automatically, click [X] button to exit the menu.

For Macintosh
Double-click the VersaWorks icon on the desktop.




Click the [SpotColorLibrary] folder, then click the [Illustrator] folder.
Copy the "Roland VersaWorks.ai" file to the [Swatches] folder inside the folder where
Illustrator is installed and set up.

This registers the spot color for drawing cutting lines in Illustrator. Now let's try drawing actual cutting lines
using this spot color.
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Drawing Contour Lines

2. Creating a Cutting Path




Start by creating a new blank document.
From the [Window] menu, choose [Swatch
Library], then click [Roland VersaWorks].
The swatch window shown in the figure appears.




Create a path you want to cut.
Choose the path you want to cut, then go
to the tool palette and choose [Pen Tool].

Click this.


Click this.



In the swatch window, choose the color you
added earlier (Cut Contour).
The color of the specified path changes to [Cut
Contour].

Save the file.

 “File Formats You Can Open Directly from VersaWorks” (p. 33)

Important Note on Using the Transparency Feature
When you're drawing a cutting path in data where objects using the transparency feature have been placed,
make sure of the following points.
 Bring the path to make the cutting path to the front.
 Set the value of "Raster/Vector Balance" to "75" or higher.
 Clear "Convert All Strokes to Outlines."
For more information, refer to VersaWorks Online.
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Drawing Contour Lines

Creating a Cutting Path with CorelDRAW
CorelDRAW 11/12/X3/X4

1.

Register the spot color in the palette editor.

Two methods are available to register a spot color named "CutContour".
Procedure A : Registering a spot color for a color provided by VersaWorks
Procedure B : Registering a spot color for a color you select

Procedure A

You replace the userinks.cpl file in CorelDRAW with the file in VersaWorks. Doing this overwrites all spot colors
that are already registered. If you want to keep already-registered spot colors, use the method described in
Procedure B to register the new spot color.
For CorelDRAW X3 only, perform this operation while logged in to an "Administrator" account.



Insert the Roland VersaWorks DVD-ROM in the DVD-ROM drive.



For Windows

If the setup menu appears automatically, click [X] button to exit the menu.

From the [Start] menu, choose [Computer (or My Computer)], then the DVD-ROM drive.
Right-click the DVD-ROM drive, then choose [Open].

For Macintosh

Double-click the VersaWorks icon on the desktop.




Click the [SpotColorLibrary] folder, then click the [CorelDRAW] folder.






Restart CorelDRAW.

Copy the userinks.cpl file to the location you want.
The userinks.cpl file already contains the "CutContour" data.

In the CorelDRAW menu, click [Tools] - [Palette Editor].
Click the [Open Palette] icon.
Select [userinks.cpl], and then click [Open].

Please select "Legacy custom palette (*.cpl)" by "Save as type" when the "userinks.cpl" file is not found
in the folder that you preserved.

This registers the spot color for drawing cutting lines in CorelDRAW. Now let's try drawing actual cutting lines
using this spot color.

 “Create a Cutting Path, then apply the spot color to the path.” (p. 57)

Part 4: Contour Cutting

55

Drawing Contour Lines

Procedure B

Register the spot color for a color you want using "CutContour" as the name.




From the [Tools] menu, choose [Palette Editor].
Display the [Select Color] window.
Select "Custom Spot
Color."



Click [Add Color].

Create a new spot color.
Click the [Models]
tab.

Select any color you
want.

Click [Add to Palette].



Click [Close] or [OK].

Change the name of the selected Custom Spot Color to [CutContour].

Select the spot color
you created.

Click [OK].

Change the name of
the color to "CutContour."
The settings are saved.
Be sure to type in the
name using single-byte
characters, and make the
"C" upper case.
Failing to specify the name
precisely will make recognition by VersaWorks impossible.

This registers the spot color for drawing cutting lines in CorelDRAW. Now let's try drawing actual cutting lines
using this spot color.
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Drawing Contour Lines

2.



Create a Cutting Path, then apply the spot color to the path.
Create a path you want to cut.
Display the [Outline Pen] Dialog.
Click this.
Click this.



Display the [Select Color] window.

Click this.

Click this.



Apply the spot color to the path.
Click the [Palettes] tab.

Select the "Custom
spot colors".

Select the "CutContour" spot
color.

Click [OK].
At the [Outline Pen] dialog, click [OK].



Save the file.

 “File Formats You Can Open Directly from VersaWorks” (p. 33)
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Drawing Contour Lines

CorelDRAW X5/X6
Procedure




Create a path you want to cut.
Display the [Outline Pen] Dialog.
Click this.
Click this.



Display the [Select Color] window.

Click this.

Click this.



Apply the spot color to the path.

Click the [Palettes] tab.

Select [Pallete Libraries]-[Spot][Roland]-[Roland VersaWorks].

Select the "CutContour".

Click [OK].
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At the [Outline Pen]
dialog, click [OK].

Drawing Contour Lines



Save the file.

 “File Formats You Can Open Directly from VersaWorks” (p. 33)

CorelDRAW X7
Procedure




Create a path you want to cut.
Display the [Select Color] window.
Click this.

Click this.
Click this.

Click this.



Apply the spot color to the path.

Click the [Palettes] tab.

Select [Pallete Libraries]-[Spot][Roland]-[Roland VersaWorks].

Select the "CutContour".

Click [OK].



Save the file.

 “File Formats You Can Open Directly from VersaWorks” (p. 33)
Part 4: Contour Cutting

59

Contour Cutting
Performing Printing Followed Immediately by Cutting
After the image is printed, the media is automatically rolled back and cut out.
You can make the settings for cutting by going to the [Queue Properties] window and using [Cut Controls].

Procedure



Display the [Queue Properties] window.
Choose either the Queue A or B input folder.

 “Making the Default Settings for Printing” (p. 48)



Make the settings for the printer.

Click the [Cut Controls] button.

In the [Operation
Mode] list, select
"Print & Cut."

Click [OK] to close
the window.



Open the file that contains the cutting path and perform the operation for RIP’ing and
printing.
After finishing printing, cutting starts automatically.

 “Performing Printing” (p. 31)
You can set the cutting parameters.
Selecting the [Enable Advanced Settings] check box lets you use VersaWorks to make the settings for the
printer's cutting parameters, such as blade force. For more information, refer to the help.
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Contour Cutting

Reloading Detached Media and Performing Cutting
When you want to detach printed media to perform lamination or the like, then reload the media and carry
out only cutting, you first add crop marks for aligning the media.

1. Printing with Crop Marks



Display the [Queue Properties] window.
Choose either the Queue A or B input folder.

 “Making the Default Settings for Printing” (p. 48)



Make the settings for the printer.

Click the [Mark] button.

Select [Crop Marks
(Print&Cut Alignment)].

In the [Operation
Mode] list, select
"Print Only."

Click the [Cut Controls] button.

Click [OK] to close
the window.



Open the file that contains the cutting path and perform the operation for RIP’ing and
printing.
The output will be printed with the crop marks.

 “Performing Printing” (p. 31)
Never draw alignment mark or crop marks using a program.
Alignment marks and crop marks drawn using a program cannot be used for alignment. If crop
marks are needed, be sure to perform printing with the settings made using this procedure.
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Contour Cutting

2. Cutting



Reload the media after the lamination and the like.



Display the [Job Settings] window.

If your printer requires to detect the crop marks, execute the necessary operation as well.
Choose and open the job you printed earlier.

 “Setting the Printing Parameters for Jobs” (p. 50)



Make the settings for the printer.
Click the [Cut Controls] button.

In the [Operation
Mode] list, select
"Cut Only."

Click [OK] to close
the window.



Print the job you printed earlier a second time.
Cutting Starts.

 “To Re-output a Printed Job Rapidly” (p. 46)
Redoing RIP'ing is not necessary.
When you perform printing a second time in step  of the procedure as described above, it is not necessary
to redo RIP'ing. The cutting data and printing data are generated at the same time when you perform RIP'ing
the first time.
When you change the operation mode to "Cut Only" and perform printing a second time, VersaWorks sends
only the cutting data to the printer. This means that as long as the media is loaded correctly and the printer is
able to detect the crop marks, cutting is performed correctly without having to redo RIP'ing.
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Contour Cutting

Cutting Only
Follow the procedure below for performing cutting only.

Procedure



Display the [Queue Properties] window.
Choose either the Queue A or B input folder.

 “Making the Default Settings for Printing” (p. 48)



Make the settings for the printer.

Click the [Cut Controls] button.

In the [Operation
Mode] list, select
"Cut Only."

Click [OK] to close
the window.



Open the file that contains the cutting path and perform the operation for RIP’ing and
printing.
Cutting Starts.

 “Performing Printing” (p. 31)

Part 4: Contour Cutting

63

64

Part 5:
Appendix
Remove VersaWorks....................................................................66
Remove VersaWorks..................................................................66

65

Remove VersaWorks
Remove VersaWorks
To remove VersaWorks from the computer, follow the steps below.

Windows Vista/7



Log on to Windows with an account with "Administrators" rights.



Removing VersaWorks.

Shut down all other programs except Windows.

From the [Start] menu, click [Control Panel], then click [Uninstall a
program].

Select [Roland VersaWorks], then
click [Uninstall].

If the message "Are you sure you want to uninstall Roland VersaWorks?" appears,
click [Yes].
When the [User Account Control] window appears, click [Yes] (or [Allow]).

If you're prompted to restart, click
[Yes] and restart the computer.



Make sure the "Roland VersaWorks" folder has been deleted.
From the [Start] menu, click [Computer].
Double-click the hard-disk drive where VersaWorks is installed.
Double-click the "Program Files" folder and make sure no "Roland VersaWorks"
folder is inside it.
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Remove VersaWorks

If the "Roland VersaWorks" folder has not been deleted, then delete it as follows.

Right-click [Roland VersaWorks]
folder, then click [Delete].

If the message "Are you sure you
want to move this folder to the
Recycle Bin?" appears, Click [Yes].

If the message "You need to confirm this operation" appears, click
[Continue].



Delete the driver for VersaWorks.

When the [User Account Control]
window appears, click [Continue].

From the [Start] menu, click [Control Panel], then click [View device
and printers] (or[Printer]).

Right-click [RolandVW], then click
[Remove device] (or[Delete]).

Click [Yes].
Windows 7

Windows Vista

Continued on the next page
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Remove VersaWorks

Windows 7: Click [>>] with other printers (device) that existed in the list
selected, and then click "Print server
properties."
Windows Vista:
Right-click inside the [Printers] folder,
click [Run as administrator], then
click [Server Properties].

Right-click inside this area.
When the [User Account Control]
window appears, click [Continue].

1

2

1 Click the [Drivers] tab.
2 Choose [Roland VersaWorks].
3 Click [Remove].

3

1
2

1 Choose [Remove driver and 		
driver package].
2 Click [OK].

If you're prompted to confirm deletion, click [Yes].
When the driver package information has been collected, click [Remove].
When the driver package has been deleted, click [OK].

Continued on the next page
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Remove VersaWorks



Delete the port for VersaWorks.
1

1 Click the [Ports] tab.
2 Choose [VERSA-A].
If two or more printers are connected, select all ports set for "Versa
File Port."
3 Click [Delete Port].

2

3

Click [OK].
This completes removal of VersaWorks.
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